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MODEL PAPER - 3 
Duration : 3 hours                                                                           Marks : 80 

Note : 
(1) In Section I, Part A Question No. 1 is compulsory. 
(2) In Section I, attempt any two questions from Question Nos. 2 to 5. 
(3) In Section II, attempt any two questions from Question Nos. 6 to 9. 
(4) Answers to both Sections should be written in the same answer book. 
(5) Figures to the right indicate maximum marks. 
 

SECTION - I  (PART - A) 
 
Q1 (a) Answer the following briefly:   [3] 
 (i) Give one advantage of Windows over MS-DOS. 
 (ii) What is Full Screen view in Ms-Word and how is it obtained. 
 (iii) What is FTP? 
 
 (b) Answer the following in ‘C’: [1+1+1+2=5] 
 (i) What is the use of ‘default’ option in switch()? 
 (ii) What are white spaces? 
 (iii) What is the use of ‘break’ statement in switch()? 
 (iv) What is an identifier? State the rules for forming an identifier. 
 
 (c) State whether the following statements are true or false: [3] 
 (i) Windows Explorer of Windows’95 allows you to search for directories and 
files. 
 (ii)  Windows Explorer of Windows’95 allows you to search the Web. 
 (iii)  Impact printers require special type of sensitive paper for printing.  

(iv) In Ms-Word, Cut/Copy option is highlighted only after the text is 
selected. 

(v) In Ms-Word, Print Preview option appears in Edit Menu. 
(vi) In Ms-Word, Font option in Format Menu provides effects such as 

subscript, superscript etc. 
 
 (d) Answer the following in Foxpro: [2+3=5] 
 (i) Explain the use of following functions: 
  DATE()  DELETED()    
 (ii) Explain the use of following commands: 
  MODIFY STRUCTURE  SET RELATION TO  SET 
DEFAULT TO 

 
Q2 (a) What does the following ‘C’ program print: [2] 
  main()                   
  { int x=1, t=0;               
  while(x<5)          
  { if (x%2 == 1)             
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    t+=x;                   
    else t-=x;                
  printf(“%d “,t); x++;                      
  if (t>20) break; }      
  printf(“t = %d”, t); } 
 

 
 (b) State whether the following statements are true or false:   [2] 
 (i) We can enter characters using a mouse. 
 (ii) Hard disk has a write protect notch. 
 (iii) Compiler is a software. 
 (iv) LAN is used to share hard disk, printer and programs. 
 
 (c) Explain briefly about the following:   [6] 
 (i) Monitor  (ii) Keyboard (iii) Internet and it’s 
advantages 
 
 (d) Write a program in ‘C’ to input name, telephone number and number of 

calls made by 20 persons and then print the name, telephone number and 
bill amount. The bill amount is calculated as follows: the first 150 calls are 
free, next 250 calls are charged @ 0.80 per call, next 600 calls are 
charged @ 1.00 per call and excess calls are charged @ 1.20 per call. A 
rent of Rs.500 has to be paid by all persons. Also add 5% of bill amount as 
service tax. [6] 

   
Q3 (a) Mention briefly the difference between the following:  [4] 

(i) Laser Printer and Dot Matrix Printer (ii) System and Application 
Software 

 
 (b) Answer the following briefly:   [4] 
 (i) What is the function of A.L.U.? 
 (ii) Give one advantage of Dot Matrix Printer over Letter Quality Printer. 
 (iii) Give one advantage of CD-ROM over Hard Disk. 
 (iv) What is the use of Spike Supressor? 
 
 (c) State whether the following statements are true or false: [2] 
 (i) A website contains information about an organisation. 
 (ii) The opening page of a website is called home page. 
 (iii) Lynx is an internet browser. 
 (iv) Usenet is a collection of networks and computers which share news 
articles. 
 
 (d) What does the following ‘C’ program print: [2] 
  #define f(p,q) 3*p-2*q  
  main() 
  { int a=10, b=12, s; 
  a-=b++; 
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  s=f(a,b)-f(b,a); 
  printf(“%d %d %d\n”, a, b, s); } 
 

(e) Write a program in ‘C’ to find and print odd numbers from 75 to 275, not 
divisible by 13. Print 20 numbers on each line. Finally print their sum. [4] 

 
Q4 (a) State whether the following statements are true or false: [4] 
 (i) In a monitor, density of pixels determine it’s resolution. 
 (ii) A serial printer prints one line at a time. 
 (iii) MS-DOS is a single user multi-tasking operating system. 

(iv) In WAN computers across different cities are connected using satellites. 
(v) A Dot matrix printer creates image of a character using combination of 
dots. 
(vi) Storage capacity of a hard disk is more than a floppy disk. 
(vii) Every computer requires CD-ROM. 
(viii) A floppy disk can be used only after formatting it. 

  
 (b) What does the following ‘C’ program print: [2] 
  #include<stdio.h> 
  main() 
  { int x = 1573, t; 
  t = fun(x); 
  printf(“%d %d\n”, x, t); } 
 
  fun(int i) 
  { int d, s=0; 
  do 
  { d=i%10;  
    s=s*10+d; 
    i/=10; } 
  while(i!=0); 
  return (s); } 
 
 (c) Explain briefly about the following: [4]  
 (i) Internet Protocols   (ii) Search Engines 
 
 (d) In a factory weekly wages of 15 workers is calculated as follows: the first 

35 hours are considered as regular hours, hours exceeding 35 are 
considered as overtime and overtime is paid @2 times the normal rate. 
Write a program in ‘C’ to input worker’s name(wn), hours worked(hr) and 
rate per hour(r) and then print worker’s name, regular wage, overtime 
wage and total wage. [6] 

 
Q5 (a) Explain briefly about the following:   [6] 
 (i) Programming Languages  (ii) Mouse (iii) WWW 
 
 (b) State whether the following statements are true or false: [2] 
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 (i) Usenet is a discussion group. 
 (ii) BBS stands of British Bulletin Service. 
 (iii) Using internet we can sell our goods. 
 (iv) Telnet stands for Terminal Emulation Network. 
 
 (c) What does the following ‘C’ program print: [2] 
  #include<stdio.h> 
  extern int c = 20; 
  main() 
  { fun(); 
  fun(); } 
 
  fun() 
  { auto int a = 20; 
  static int b = 20; 
  a+=10; b-=10; c*=10; 
  printf(“%d %d %d\n”, a, b, c); } 
   

(d) Write a program in ‘C’ to input marks of 100 students in a test and then 
prepare and print frequency table with class intervals 0-35, 35-45, 45-60, 
60-75, 75-90, 90-100.  [6] 

  
SECTION - II 

 
Q6 (a) Answer the following in Windows’95: [4] 
 (i) Explain how to recover a deleted file/folder. 
 (ii) What is the use of Windows Explorer? 
 
 (b) Answer the following in Ms-Word: [4] 
 (i) Explain where formatting toolbar is displayed and what does it contain. 
 (ii) Explain how will you open the document TODAY.DOC, save it as 

TOMO.DOC, find the word “TODAY” and replace it with “TOMORROW”.  
 

(c) There is a file called PAYROLL containing the fields employee no. 
(EMP_NO,N,4), employee name (EMP_NAME,C,20), department 
(DEPT,C,10) and basic pay (B_PAY,N,8,2).  

 
 Write a Foxpro program to print a payroll report showing  employee no., 

employee name, department,  basic  pay, dearness  allowance (DA), 
house rent allowance (HRA) & gross  pay (GR), where DA is computed as 
follows: [4] 

  BASIC PAY                           D.A.  
  First Rs.2000                       130% of basic pay 
  Next Rs.5000                        120% of basic pay 
  Excess                              110% of basic pay 
  HRA is @10% of basic pay + DA or 4000  whichever is less. Minimum 
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HRA is 1000 
  The report should be printed in the alphabetical order of names 
department wise. 
 
 (d) There is a table called ADDRESS.dbf containing fields Name 

(NAME,C,20), Building Address (BLD_ADD,C,15), Street Address 
(ST_ADD,C,15), City (CITY,C,10) and Pin-code (PIN,N,6). Write a Foxpro 
program requesting the user to enter the name of city and the program 
should print all the addresses from that city in the alphabetical order of 
names, whenever the city is found. Otherwise display “NO RECORDS OF 
THAT CITY FOUND”. The program must allow the user to continue. [4] 

 
Q7 (a) Explain how will you change the date and time in Windows’95. [2] 
 
 (b) Explain the procedure to include the expression d1 = b2 - 4ac as part of the 

document currently being edited in Ms-Word. [2] 
 
 (c) State whether the following statements are true or false in Ms-Word: [2] 
 (i) Close option in the File menu  not only closes the file but also terminates 

Ms-Word. 
 (ii) Text can be selected using a mouse or a keyboard. 
 (iii) Page break always starts a new page from the cursor position. 
 (iv) Page numbers can appear in header or footer or in both. 
 
 (d) Explain the difference between the following in Foxpro: [6] 
 (i) GO TOP and GO 1 (ii) INDEX and SORT  (iii) ? 
and ?? 
 
 (e) There exists a table called CUSTOM.dbf containing fields Item name 

(INAME, Character, 20),  Price (PRICE, Numeric, 5, 0) and Duty paid 
(DUTY,Numeric,8,2). Write a Foxpro program to print a list showing item 
name, price and duty paid in the descending order of duty paid. All the 
items names should be printed in uppercase. [4] 

 
Q8 (a) Answer the following in Windows’95: [4] 
 (i) What is the use of Recycle Bin? 
 (ii) What is the use of My Computer? 
 
 (b) Answer the following in Ms-Word: [4] 
 (i) Currently you are editing a file and you have entered 5 questions in 5 lines. 

Explain how do you make a table and include these questions in the table 
and then add 3 new rows in order to add 3 more questions.  

 (ii) What is the use of Table Menu? Discuss any four options of this menu. 
 
 (c) There is a file called INVENT containing fields Item no. (INO, N, 4), Item 

Name (INAME, C, 20), Quantity (QTY, N, 5) and Price per unit (PRICE, N, 
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8, 2). Write an interactive Foxpro program requesting the user to enter 
item name and then the program must search whether the item name is 
found in the file or not. If it is not found then display “Item not found in the 
file”, otherwise display all the details and then request the user whether he 
wants to delete the record or not, if yes delete the record. The program 
must allow the user to continue as long as the user wants. [4] 

 
 (d) Explain the difference between the following in Foxpro: [4] 
 (i) SELECT and USE  (ii) EDIT and BROWSE  
 
Q9 (a) Answer the following in Windows’95: [4] 
 (i) What is the use of Documents Menu? 
 (ii) Explain how will you move a folder named TALLY from C drive to D drive.
  
 
 (b) Explain the method to perform the following operations in Ms-Word: [4] 
 (i) To search for a word. 
 (ii) To load a file called MP3.DOC and begin editing from the 4th page. 
 (iii) To change the Page Setup. 
 (iv) To create a bulleted list. 
 
 (c) Explain the difference between the following in Foxpro: [4] 
 (i) INPUT TO and @Row/Col SAY/GET/READ (ii) LOOP and EXIT  
   
 (d) A Foxpro table MARKS.dbf contains the fields roll number(RNO,N,5), 

name(NAME,C,15) and result (RESULT,C,12). Write a Foxpro program 
requesting the user to enter roll number and then the program must find 
whether the roll number is present in the file or not. If so, then display the 
roll number, name and result on the screen otherwise allow the user to 
add this as a new record. The program must allow the user to continue as 
long as desired. [4] 

 
 

 
Important Note : 
1.  How to do your last moment preparations: 
a.  Thoroughly revise the Model Papers 3, 2, 1 (in the given sequence) 
b.  From Model Papers, do written practise of Foxpro and ‘C’ programs and ‘C’ 

mention the output. 
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MODEL PAPER - 3 SOLUTION 
Duration : 3 hours                                                                  Marks : 80 

SECTION - I  (PART - A) 
 
1a (i) Windows provides a user friendly graphical interface. It is also capable of 

multi-tasking. 
 (ii) Full Screen view displays only the document and a Full Screen Button on 

the lower-right corner of the screen. It removes menus, toolbars, 
scrollbars etc. from the screen. To obtain Full Screen view, Select View 
menu - Select Full Screen. 

 (iii) FTP stands for File Transfer Protocol. This protocol is used to upload or 
download files from the internet. 

 
1b (i) In switch() statement if the expressions does not match any case then the 

default option is executed. 
 (ii) Blank lines, tabs and blank spaces are known as white spaces in ‘C’. 
 (iii) In switch() statement, break is used to indicate the end of the case. If 

break statement is not written, execution will continue into the next case. 
 (iv) Identifiers are names given by the programmer to variables, arrays, labels, 

user defined functions and library routines. There are certain rules for 
using them: 

  a. The first character must be an alphabet A-Z, a-z or underscore(_).  
  b. It can be followed by characters: alphabets, digits 0-9, underscore or 

slash(/).   
  c. It must be maximum 32 characters. 
  d. It must not be a keyword. 
  e. It must be unique. Upper and lower case identifiers are not same. 
 
1c  (i) TRUE (ii) FALSE (iii) FALSE (iv) TRUE (v) FALSE (vi)

 TRUE 
 
1d  (i) DATE(): This function will give the current system date. The date is 

displayed in mm/dd/yy format. E.g.  ? DATE() Output: 03/28/02 
   DELETED(): This function is used to reference the records which are 

marked for deletion.   E.g. LIST FOR DELETED(),  LIST FOR NOT 
DELETED() 

  (ii) MODIFY STRUCTURE: This command is used to make changes in the 
structure of the database. Using this command one can add new fields, 
delete fields, change the fieldname, type, width or decimal places.  

   SET RELATION TO: This command is used to make the record pointer 
move in both the files together based on the common field.  

   E.g.  SET RELATION TO ROLL_NO INTO MARKS 
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   SET DEFAULT TO: This command is used to change the default drive to 
the drive specified.  E.g. SET DEFAULT TO A 

 
2a   Output 
   1b-1b2b-2btb=b-2 b denotes blank space 
 
2b (i) FALSE (ii) FALSE (iii) TRUE  (iv) TRUE 
 
2c (i) Monitor : The term monitor refers to Visual Display Unit (VDU). It is an 

output device on which the keyboard input, results of processing and 
computer messages are displayed. Every computer requires a Monitor. It 
contains a glass picture tube called as Cathode Ray Tube (CRT). 

  Monitors are the fastest Output devices. However they provide a 
SOFTCOPY of the output as the results displayed on the screen are lost 
the moment the power is switched off. Thus, they are temporary output 
devices. Some other features of monitors are : 

 a. Cursor : It is a small bright blinking mark on the screen. 
 b. With regard to colour  there are 2 types of Monitors : Monochrome and 

Colour. 
 c. Resolution : It refers to sharpness and clarity of the images on the screen. 

There are three different levels of resolution - Low, Medium and High. 
 d. The monitor provides display for 25 rows/lines of characters, each row 

comprises of 80 characters/columns. 
 e. In case of colour monitors it is observed that higher the resolution lesser is 

the number of colours available and vice-versa. 
  
 (ii) Keyboard: This is the standard Input device. Every computer requires a 

Keyboard. It consists of a board with several keys (buttons), hence the 
name Keyboard. When a key is pressed an electronic signal is generated 
by the keyboard and sent to the CPU. There are a variety of Keyboards 
available depending on the no. of keys : 101, 104, 105 keys etc.  The 
vaious keys on the keyboard are arranged in groups. These groups are : 

 a. Typing Pad : This set of keys is in the middle of the Keyboard and the 
arrangement of the keys is similar to that of a typewriter. There are keys 
for alphabets A - Z, digits 0 - 9 and special characters like + - * / $ % , etc. 
In addition there are also special keys like : Enter, Shift, backspace etc. 

 b. Function keys: These keys are marked as : F1,F2 … F12. The functions of 
these keys is not fixed and depends on the program in use. They are also 
called Programmable keys. 

 c. Cursor Movement Keys : These keys help us to move the cursor. They are 
Up, Down, Left, Right, Pgup, Pgdn, Home, End etc. 

 d. Numeric Pad: They consist of keys for digits 0 - 9. The arrangement of 
keys is similar to that of a calculator. These are dual function keys. Their 
other function is to control cursor movement - up, down, left, right, page up, 
page down, home, end etc. 
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 (iii) Internet and it’s advantages: Internet is a network of networks. It is 
basically a network with thousands of computers connected to each other. 
It also consists of transmission lines, routers, servers, etc. It allows 
computers to communicate with each other globally irrespective of their 
geographical location. It is also described as an information superhighway. 
Some of the advantages of internet are: 

 a. World Wide Web (WWW): WWW consists of thousands of websites giving 
information about almost anything. Millions of files stored on computers 
throughout the world can be searched, accessed and retrieved. 

 b. Electronic Mail: E-mail can be exchanged with millions of people at a very 
low cost. 

 c. IRC(Internet Relay Chat): IRC allows people to communicate in real time 
with others connected to the internet. 

 d. Web Advertising and Marketing: Various companies have their website to 
promote and provide their products and services.  

 
2d   #include<stdio.h> 
   main() 
   {  
   char name[10]; 
   long int tn; 
   float nc, ba, st, i; 
   for (i=1; i<=20; i++) 
   {  
   printf("ENTER NAME, TELEPHONE NO. AND NO. OF CALLS"); 
   scanf("%s %ld %f", name, &tn, &nc); 
   if (nc <= 150) 
    ba = 0; 
   else if (nc > 150 && nc <= 400) 
    ba = (nc-150) * 0.80; 
   else if (nc > 400 && nc <= 1000) 
    ba = 200  + (nc-400) * 1.00; 
   else 
    ba = 200 + 600 + (nc-1000)*1.20; 
   st = ba * 0.05  
   ba = ba + st + 500; 
   printf("NAME = %s\n", name); 
   printf("TELEPHONE NO. = %ld\n", tn); 
   printf("BILL AMOUNT = Rs %.2f\n", ba);  
   } } 
 
3a (i) Laser Printer: It is a non-impact and page printer. They are noiseless, 

extremely fast and offer excellent print quality. 
   Dot Matrix Printer: It is an impact and character printer. They are noisy, 

slow and do not offer good print quality. 
 (ii) System Software: These are programs which control the working of the 
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computer system. They form an integral part of the computer system 
without which the computer cannot be operated nor can the application 
software be executed. They are generally provided by the computer 
manufacturer.  

   E.g. Operating Systems, Translators etc.  
   Application Software: These are programs needed by the user to do his 

own applications or jobs. They are generally written by the user himself or 
obtained from software companies. They cannot work on their own, they 
require the support of system software. E.g. Ms-Word, Ms-Excel, Foxpro 
etc. 

 
3b (i) The function of the Arithmetic and Logic Unit is to perform calculations, 

comparisons and decision making operations. 
 (ii) Dot Matrix Printer is faster than Letter Quality Printer as it prints 

bi-directionally. They can also be used for designing applications. They 
can print in different fonts, styles and sizes. 

 (iii) CD-ROM is easily removable and transportable. It is cheap. 
 (iv) Spike Supressor avoids fluctuations in electricity from reaching and 

damaging your computer system. 
 
3c (i) TRUE (ii) TRUE  (iii) TRUE  (iv) TRUE 
  
3d  Output: -2b13b-67 b denotes blank space  
 
3e #include<stdio.h> 
 main() 
 { int i, s=0; 
 for (i=75; i<=275; i=i+2) 
  { 
  if (i%13 != 0) 
   { printf("%4d", i); 
   s = s + i; } 
  } 
 printf("\nSUM = %d\n", s); } 
 
4a (i) TRUE (ii) FALSE (iii) FALSE (iv) TRUE  
 (v) TRUE (vi) TRUE  (vii) FALSE (viii) TRUE 
  
4b  Output:  1573b3751 b denotes blank space 
 
4c (i) Internet Protocols: Protocols are  set of rules defined for smooth and 

efficient working of a network. In other terms, it refers to the set of rules 
that govern the communication between computers on the internet. 
Examples of protocols are: 

 a. TCP/IP (Transmission Control Protocol/Internet Protocol)  enables 



Provided By TyBcom.com 

11of 20 

different types of computers in the network using different operating 
systems, to communicate with each other efficiently. All computers on 
internet are connected using the TCP/IP protocol. 

 b. SLIP (Serial Line Internet Protocol) allows the user to connect the 
computer directly to the internet through a modem. 

 c. POP (Post Office Protocol) is a facility whereby e-mail is fetched from a 
remote mail-box (i.e. mail-box on some other machine) and stored on the 
user's machine so that it can be read later. Software required for POP mail 
are Eudora, Outlook Express, etc. 

 d. FTP (File Transfer Protocol) is used to upload or download files from 
internet. 

 
 (ii) Search Engines: Search engines are the websites on the web where a 

word or a phrase can be entered and they immediately display a list of 
documents containing the specified word or phrase. Examples of some 
search engine sites are: www.yahoo.com, www.lycos.com, 
www.altavista.com 

 
4d  #include<stdio.h> 
  main() 
  { char wn[10]; 
  float i, hr, r, rw, ow, tw; 
   for (i=0; i<=15; i++) 
  { 
  printf(“ENTER THE NAME, HOURS WORKED AND RATE “); 
  scanf(“%s %f %f”, wn, &hr, &r); 
  if (hr <= 35) 
    { rw = hr * r; 
      ow = 0; } 
   else 
    { rw = 35 * r; 
      ow = (hr-35) * (2*r); } 
  tw = rw + ow; 
  printf(“WORKERS NAME = %s\n”, wn); 
  printf(“REGULAR WAGE = %.2f\n”, rw); 
  printf(“OVERTIME WAGE = %.2f\n”, ow); 
  printf(“TOTAL WAGE = %.2f\n”, tw);  } } 
 
5a (i) Programming Languages: To make a computer do our tasks we need to 

communicate with it in a language it understands. Such languages are 
called Programming Languages. They are classified as follows:  

  Machine Language: In this language instructions are given to the 
computer as a group of binary digits i.e 0's and 1's. This language is 
difficult to learn and use. Programs written in this language are executed 
very rapidly by the computer as this language is understood by computer.  

  Assembly Language: In this language abbreviations and symbols called 
mnemonic's are used  to give instructions to the computer. It is far more 
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easier to learn and use compared to machine language. These programs 
cannot be executed by the computer unless they are translated into 
machine language using a Translator called Assembler.  

  High Level Languages: In these languages English words, mathematical 
and algebraic symbols are used to give instructions to the computer. They 
are easy to learn and use. Programs written in these languages have to 
be translated into machine language using Translators. e.g. FoxPro, C 
etc. 

 
(ii) Mouse: A Mouse is a pointing device. It is gently moved on a mouse pad 

or any flat surface. It is a rectangular box with two buttons on the top, a left 
button and a right button. It has a sensor which locates its position on the 
pad and translates it into corresponding arrow position on the screen. As 
the mouse moves, the arrow pointer on the screen also moves 
accordingly. Computers today, provide a graphical and user friendly 
interface e.g. Windows. When working with Windows, user interacts with 
the computer visually, by moving a pointer around the screen with a 
mouse and select different options by clicking on them. 

  
 (iii) WWW: The World Wide Web (WWW) consists of thousands of web sites 

giving information about almost anything. Millions of files stored on 
computers throughout the world can be accessed, searched and 
retrieved. 

 
5b (i) TRUE  (ii) FALSE (iii) TRUE  (iv) TRUE 
 
5c  Output:  
   30b10b200     b denotes blank space 
   30b0b2000 
 
5d   #include<stdio.h> 
   main() 
   { int i, c1=0, c2=0, c3=0, c4=0, c5=0, c6=0; 
   float m; 
   for (i=1; i<=100; i++) 
   { printf("ENTER THE MARKS "); 
   scanf("%f", &m); 
   if (m >= 0 && m < 35) 
    c1 = c1 + 1; 
   else if (m >= 35 && m < 45) 
    c2 = c2 + 1; 
   else if (m >= 45 && m < 60) 
    c3 = c3 + 1; 
   else if (m >= 60 && m < 75) 
    c4 = c4 + 1; 
   else if (m >= 75 && m < 90) 
    c5 = c5 + 1; 
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   else 
    c6 = c6 + 1; } 
   printf("FREQUENCY DISTRIBUTION TABLE\n"); 
   printf("CLASS\tNO. OF\n"); 
   printf("INT.\tSTUDENTS\n"); 
   printf("0-35\t%d\n", c1); 
   printf("35-45\t%d\n", c2); 
   printf("45-60\t%d\n", c3); 
   printf("60-75\t%d\n", c4); 
   printf("75-90\t%d\n", c5); 
   printf("90-100\t%d\n", c6); } 
 

SECTION - II 
 
6a (i) To recover the file/folder which was deleted, follow these steps : 
 a. Double-click on the Recycle Bin icon on the Desktop. 
 b. Select the file/folder which was deleted.  
 c. Select File Menu - Select Restore. 
 d. Select File Menu - Select Close. 
 (ii) Windows Explorer is a special program in Windows used to explore files, 

folders or disks. It can be used to view, copy, move, rename, delete files 
or folders. 

 
6b (i) Formatting Toolbar is a set of icons to format the text. It appears below the 

Standard Toolbar. Some of the icons from this toolbar are Font, Font Size, 
Bold, Italic, Underline, Align Left/Right/Center, Bullets etc.  

 (ii) To do so, follow these steps : 
 a. Select File Menu - Select Open. We will now get Open dialog box. 
 b. Select the drive or folder where the file is stored. 
 c. Select the file TODAY.DOC. And, then select Open button.  
 d. To save as TOMO.DOC - Select File Menu - Select Save As. 
 e. We will now get the Save As dialog box. Select the desired drive or folder 

in which we want to save the file. 
 f. Type the new filename TOMO.DOC. And, then select Save button.   
 g. To replace the word TODAY with TOMORROW - Bring the cursor to the 

beginning of the the document.  
 h. Select Edit Menu - Select Find. We will now get the Find and Replace 

dialog box. 
 i. Enter the text to be searched - TODAY.  
 j. To replace - select Replace button. Type the new text - TOMORROW. 
 k. And, then select Replace All button to replace all occurrences of the text 

searched. 
 
6c  SET TALK OFF 
  SET DEVICE TO PRINTER 
  USE PAYROLL 
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  INDEX ON DEPT + EMP_NAME TAG DN 
  @ 1,36 SAY “PAY-SHEET” 
   @ 2,0  SAY “ENO” 
  @ 2,5  SAY “EMPLOYEE NAME” 
  @ 2,28 SAY “DEPARTMENT” 
  @ 2,40 SAY “BASIC” 
  @ 2,50 SAY “DA” 
  @ 2,60 SAY “HRA” 
  @ 2,70 SAY “GROSS” 
  R = 3 
  DO WHILE NOT EOF() 
  IF B_PAY <= 2000 
    DA = B_PAY * 1.30 
 ELSE 
  IF B_PAY > 2000 AND B_PAY <= 7000 
     DA=(2000*1.30) + (B_PAY-2000)*1.20 
 ELSE 
     DA=(2000*1.30)+(5000*1.20)+(B_PAY-7000)*1.10 
    ENDIF 
  ENDIF 
  HRA = (B_PAY+DA)*0.10 
  IF HRA > 4000 
    HRA = 4000 
  ELSE 
    IF HRA < 1000 
     HRA = 1000 
    ENDIF 
  ENDIF 
  GR = B_PAY + DA + HRA 
  @ R,0  SAY EMP_NO 
  @ R,5  SAY EMP_NAME 
  @ R,28 SAY DEPT 
  @ R,40 SAY STR(B_PAY,8,2) 
  @ R,50 SAY STR(DA,8,2) 
  @ R,60 SAY STR(HRA,8,2) 
  @ R,70 SAY STR(GR,8,2) 
  SKIP 
  R = R + 1 
  ENDDO 
  CLOSE ALL 
  SET TALK ON 
  SET DEVICE TO SCREEN 
  RETURN 
 
6d  SET TALK OFF 
  USE ADDRESS 
  INDEX ON CITY+NAME TAG CN 
  STORE "Y" TO ANS 
  DO WHILE UPPER(ANS) = "Y" 
  CLEAR  
  STORE SPACE(20) TO MCITY 
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  @ 5,20 SAY "ENTER THE CITY" GET MCITY 
  READ 
  SEEK MCITY 
  IF FOUND() 
   SET PRINT ON 
   DO WHILE CITY = MCITY 
   ?NAME 
   ?BLD_ADD 
   ?ST_ADD 
   ?RTRIM(CITY)+"-"+STR(PIN,6,0) 
   ? 
   SKIP 
   ENDDO 
   SET PRINT OFF 
  ELSE 
   @ 7,20 SAY "NO RECORDS OF THAT CITY FOUND" 
  ENDIF 
  @ 9,20 SAY "DO YOU WANT TO CONTINUE ?" GET ANS 
  READ 
  ENDDO 
  CLOSE ALL 
  SET TALK ON 
  RETURN 

 
7a  To change the date and time, follow these steps : 
 a. Right click on the time displayed on the right end of the Taskbar.  
 b. Select Adjust Date/Time. 
 c. We will now get Date/Time Properties dialog box. 
 d. To change date - change the day, month and year as required. 
  To change time - change the hours, minutes and seconds as required. 
 e. Click on OK. 
 
7b  To do so, follow these steps: 
 a. Bring the cursor to the desired location. Type d1 = b2 - 4ac 
 b. Select 1. Select Format Menu - Select Font. 
 c. We will now get the Font dialog box. 
 d. Select Subscript effect. And, then select OK. 
 e. Select 2. Select Format Menu - Select Font. 
 f. We will now get the Font dialog box. 
 g. Select Superscript effect. And, then select OK. 
  
7c (i) FALSE (ii) TRUE  (iii) TRUE  (iv) TRUE  
 
7d (i) GO  TOP:  This command takes the record pointer  to  the  first record  in 

the database file. This may not necessarily be  record no. 1, if the file is 
indexed. 

   GO 1: This command positions the record pointer on record number 1. 
This may not be the first record, if the file is indexed. 
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 (ii) INDEX: The index command organises the data and creates an index file 
containing the indexed order, retaining old record  numbers. The index file 
is simultaneously opened along with the  database, so one can directly 
see the organised information. 

  SORT: This command sorts the data and creates a  new  database file  
which contains the records in sorted order with new  record numbers  and  
to  see the sorted order one has to  open  the  new database file.  

(iii) ? gives a line feed i.e. moves the cursor  to  the next line and then displays 
the output.  

  ?? displays the output on the same line on which the cursor is currently 
positioned. 

 
7e  SET TALK OFF 
  SET DEVICE TO PRINTER 
  USE CUSTOM 
  INDEX ON DUTY DESCENDING TAG DD 
  @ 1,0  SAY “ITEM NAME” 
  @ 1,25 SAY “PRICE” 
  @ 1,35 SAY “DUTY” 
   R = 2 
  DO WHILE NOT EOF() 
  @ R,0  SAY UPPER(INAME) 
  @ R,25 SAY PRICE 
  @ R,35 SAY DUTY 
  SKIP 
  R = R + 1 
  ENDDO 
  CLOSE ALL 
  SET TALK ON 
  SET DEVICE TO SCREEN 
  RETURN 
 
8a (i) The Recycle Bin is a place where all deleted files/folders are kept and are 

not physically deleted from the hard disk until you ‘Empty’ the Recycle Bin. 
You can also ‘Restore’ files/folders. Recycle Bin  icon is located on the 
desktop. 

 (ii)  My Computer is used to access the hardware and information stored 
within the computer. This window contains icons for all the disk drives, 
control panel, printers etc. 

 
8b (i) To do so, follow these steps : 
  a. Select the text (5 questions). 
  b. Select  Table menu - select Convert Text to Table. 
  c. We will now get Convert Text to Table dialog box. 
  d. Enter the details regarding number of columns, column width etc. 
 e. And, then select OK. 
  To add 3 new rows : 
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 a. Place the cursor in the last cell of last row. 
 b. Select Table Menu - select Insert Rows. 
 c. We will now get Insert Rows dialog box. 
 d. Type 3. Select OK. 
  (ii) Table menu contains options used to create, edit and sort tables. Using 

this menu one can insert or delete rows, select rows or columns, turn 
on/off gridlines of a table etc. It is activated by follwing ways : 

 a. Move the mouse pointer on the Table menu and click the left mouse 
button. OR 

 b. Press Alt + A keys. 
   Options from this menu are :  
 a. Insert Table: It is used to insert a table at the current cursor position. 
 b. Select Row:It is used to select the row where the cursor is currently positioned. 
 c. Select Column: It used to select the column where the cursor is currently 

positioned. 
 d. Cell Height and Width: It is used to adjust row heights and column widths.  
 e. Convert Text to Table: It is used to create a table from the selected text. 
 f.  Sort Text: It is used to arrange the text in the table in ascending or 

descending order. 
 g. Gridlines: It is used to turn on/off the gridlines. 
 
8c  SET TALK OFF 
  USE INVENT 
  STORE "Y" TO ANS 
  DO WHILE UPPER(ANS) = "Y" 
  CLEAR 
  STORE SPACE(20) TO MINAME 
  @ 5,20 SAY "ENTER THE ITEM NAME" GET MINAME 
  READ 
  LOCATE FOR INAME = MINAME 
  IF FOUND() 
   @ 7,20 SAY "ITEM NO. = " + STR(INO,4,0) 
   @ 9,20 SAY "ITEM NAME = " + INAME 
   @11,20 SAY "QUANTITY = " + STR(QTY,5,0) 
   @13,20 SAY "PRICE PER UNIT = Rs." + STR(PRICE,8,2) 
   STORE "Y" TO X 
   @15,20 SAY "DO YOU WANT TO DELETE THIS RECORD ?" GET X 
   READ 
   IF UPPER(X) = "Y" 
    DELETE 
    PACK 
   ENDIF 
  ELSE 
   @ 7,20 SAY "ITEM NOT FOUND IN THE FILE."  
  ENDIF 
  @19,20 SAY "DO YOU WANT TO CONTINUE ?" GET ANS 
  READ 
  ENDDO 
  CLOSE ALL 
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  SET TALK ON 
  RETURN 
 
8d (i) SELECT: This command is used to select the work area in the memory 

before opening a database file.  E. g.  SELECT A 
  USE: This command is used to open a database file in a selected work 

area.  
  E.g.  USE MARKS  
 (ii) EDIT:This command is used for editing a record. It displays one record at 

a time on screen and allows us to make changes in it. 
  BROWSE: This command is used for global editing of records. It  will 

display many records on the screen one below the other and allow us to 
make changes in them. 

 
9a (i) The Documents Menu displays a list of the last 15 documents which are 

opened directly from windows and not from any application. Select the 
desired document and click the left mouse button, the application 
associated with the document starts and the corresponding document is 
opened. 

(ii) To do so, follow these steps: 
a. Select Start - Select Programs - Select Windows Explorer. 
b. Double click on C drive. 
c. Select the folder TALLY. 
d. Select Edit Menu - Select Cut. 
e. Double click on D drive. 
f. Select Edit Menu - Select Paste. 

 
9b (i) To search for a word, follow these steps: 
 a. Bring the cursor at the beginning of the document. 
 b. Select Edit Menu - Select Find. 
 c. We will now get the Find dialog box. 

d. Enter the text to be searched.  
 e. Then, select Find Next button to begin the searching process. 
 (ii) To do so, follow these steps: 
 a. Select File Menu - Select Open. 
 b. We will now get Open dialog box.  
 c. Select the drive or folder where the file is stored. 
 d. Select the file MP3.DOC.  
 e. And, then select Open button.  
 f. To begin editing from the 4th page - Select Edit Menu. Select Go To. 
 g. We will now get Find and Replace dialog box. 
 h. Select Page. Type 4 as Page number. 
 d. Select Go To button to go to 4th page. Select Close button  to return back to the document
 (iii) To change the Page Setup, follow these steps: 
 a. Select File Menu  - Select Page Setup. 
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 b. We will now get Page Setup dialog box. 
 c. Enter the details regarding margins, paper size etc. 
 d. And, then select OK. 
 (iv) To create a bulleted list, follow these steps: 
  Select the text using the keyboard or mouse. 
 a. Select Format Menu - Select Bullets and Numbering. 
 b. We will now get Bullets and Numbering  dialog box. 
 c. From the available list, choose the required type - Select OK. OR  
  Just select the Bullets icon from the Formatting toolbar. 

 
9c (i) INPUT TO: This command is normally used for  inputting numeric data 

through the keyboard. 
  @Row/Col SAY/GET/READ: This set of commands is  used  to  display  

the contents of fields or memory variables at a specific position  of the 
screen and allow us to make changes in it. 

(ii) LOOP: This command is used to transfer the control to the beginning of 
the loop. 

  EXIT: This command is used to terminate the loop & go to the statement 
after ENDDO. 

 
9d  SET TALK OFF 
  USE MARKS 
  STORE "Y" TO ANS 
  DO WHILE UPPER(ANS) = "Y" 
  CLEAR 
  STORE 0 TO MRNO 
  @ 5,20 SAY "ENTER THE ROLL NO." GET MRNO 
  READ 
  LOCATE FOR RNO = MRNO 
  IF FOUND() 
    @ 7,20 SAY "ROLL NO. = " + STR(RNO,5,0) 
    @ 9,20 SAY "NAME = " + NAME 
    @11,20 SAY "RESULT = " + RESULT 
  ELSE 
    STORE "Y" TO X 
    @ 7,20 SAY "DO YOU WANT TO ADD THIS RECORD ?" GET X 
    READ 
    IF UPPER(X) = "Y"  
   APPEND BLANK 
   REPLACE RNO WITH MRNO 
   @ 9,20 SAY "ENTER THE NAME" GET NAME 
   @11,20 SAY "ENTER THE RESULT" GET RESULT 
   READ 
    ENDIF 
  ENDIF 
  @13,20 SAY "DO YOU WANT TO CONTINUE ?" GET ANS 
  READ 
  ENDDO 
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  CLOSE ALL 
  SET TALK ON 
  RETURN 
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